WO MEDIA SALES WIDEORBIT

Selling Against Cable

Before preparing to sell against cable, be sure you know what cable looks like in your market. Fill in
the form below as accurately as possible.

Your DMA Households:

Your Cable Households:

Cable is % of your DMA
How many cable systems in your DMA?

How is your market divided among subscribers to these cable providers?

AT&T % of Cable Subscribers in your market % of DMA
Charter % of Cable Subscribers in your market % of DMA
Comcast % of Cable Subscribers in your market % of DMA
Other % of Cable Subscribers in your market % of DMA
Other % of Cable Subscribers in your market % of DMA

When a client is presented a cable package, ratings/thousands estimate, they see numbers for the
entire cable universe; which includes all cable providers in their market market combined. Who is
presenting this? ONE cable provider. What this report will deliver is viewers of ONE service, ONE cable
provider — but the numbers presented actually represent all providers in the market. Furthermore,
this provider may be divided into separately insertable “zones” and deliver only some of these zone’s
numbers.

But, even in a best case, the buyer is not likely to see accurate numbers. For example, let’s say all zones
from the largest cable provider are bought, and that provider has 70% of the cable market. If the program’s
numbers show 10,000 viewers, the delivery on this buy can’t possibly be more than 7,000.

They are also using the Hard Wired Cable universe. This will make their percentages (ratings) larger than
if they were using the DMA — they look better and your ratings (broadcast stations) are down. If they
used the DMA, it would include over-the-air broadcast and any alternate delivery system (ADS) viewing
for broadcast stations*, so their ratings are down while yours are back where they should be! You should
always use DMA to compare yourself against cable; just be aware that this is not what the cable provider
is using. (The least confusing way to see this? Use Thousands- 000. The number of viewers for a cable
program will be the SAME in HWC or DMA demos. The number of viewers for a broadcast program will
be higher using DMA.) But each market is different. For some, HWC only covers half the DMA. For others,
it’s close to 100 per cent. So, it’s advised to know your market before competing with cable.

*ADS for cable networks is NOT included in our DMA numbers because ADS cable is NOT locally insertable. You can see the difference in these
numbers by pulling HWC, DMA, and TVS (total viewing sources) Households in Report Builder.
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Cable Ratings in WO Media Sales

Nielsen ViP Cable (CNSI) for every actual ratings survey are included in WO Media Sales. Some stations
also subscribe to Overnight Cable data: check to be sure (Click on Research then click Overnights in the
left navigation pane. Select Daily Grid and pull a popular cable network to see if numbers come in.)
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Research = Overnights
Favorites ~l
" - - Daily Grid
&9 Vedia Seles Inbox @ T soith e ok T el ) e S
() Campaigns L
1) Posts
i Mt Iti-Day Grid

— ~ 2 mukti<iay grd containing unlimited stations and unlimied time block averages,
(BB TV Research

() ReportBuiders § Week-At-A-Glance

() TrendBuilders Create a report for 3 specfic week comparing stations acrass unlimited tme blocks,

(L) ComparaTrends

(L) Trenders

(L) Rankers ‘@ Episode Tracker

() Bock Comparisons Greste 2 report contzining Spcific programs with unlimited demes,

(L) Bock Breakouts

@ TV Comparisans

,J Market f Stations List Week By Week

SyMarketseope Create a report comparing weeks across unlimited stations.

‘l‘ 8 Overights |||

Program Ranker

Create 2 program ranking report using ovemights with unlimited demes,

Sweep To Date
Create 2 report comparing a sweep book to ovemights with unlimited demas,

.“‘;»""

Overnight Auto-Deliveries
Manage your ovemight deliveries for your dily and multi<dsy grid reports.

ra—
jOo

-

One quick way to get the cable info needed: In an avail, be sure to have a Time Period book selected (Not
sure? Select the Edit tab and go to Edit Books. Look in Selected Surveys on the far right. Is the Icon by
one of the books green? If not, choose a book from the far left column). These are the books in which
cable information is available.
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If pitching news, for instance, and the buyer is also considering cable, pull the competition into the
avail for a direct comparison. Highlight one of the offered programs, then look for the Program Details
button in the ribbon under the File tab (or right-click).

v .42 [{]Copyline | #d Delete Line gy Default SortCodes | CloneProgram
o = e
nt Import Excel Send Faste Line & Delete Product Q% Add One-Time-Only Qﬁ Program Details
tions Exports Avail Actions Programming Actions
Internet LIVE REMOTE | Multi-Media |

Flanner Charts  Order  Graphical Ranker

S | £] Sorting...
Program Info Meed Rate DMA HH
1 |DP |Program Mame |T|me |Book |Rate Level |Rate |SL Rate |Raﬁng Rix_;|| Shr|
M Mo-Fr 6:00p-6:30p  |LPMar/2013LP (pa (Mone) 130 £0.00 1.07 pl.07 p2.10

4th Qtr 2013

1 Mo-Fr 6:00p-7:00p  |LPApr/2014L0 4th Qtr 2013 £0.00(:20 £0.00 D.Qll 0.91 1.84

The primary program will display (the program highlighted in the avail), then PAV numbers for broadcast
competition. Scroll down, to see Time Period competition. All cable stations and numbers, anything
competing with the primary program, will be found there.

Tag the cable line and click the Insert Into Report button.

The cable spots cost next to nothing, but who is going to see these spots. As shown here, sometimes the
difference is more dramactic if the demos in thousands is shown.
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Shown in this example are three of the more popular cable nets. Often, a cable provider will sell a
package which includes every network available. In some instances, it may help to show a list of small
or no audience cable networks, too! A list of zeros can certainly indicate “no value for the money”.
Remember, the cable stations can be filtered out in the end if a package is actually being built.

FIOGIam 4o UIFIA F 23T | LIMA F 231

|station |Program Name | Time |Rate s Rig| cer| (ooa)| C

be |GSF  [ACTION NEWS AT 6PM  |Mo-Fr 6:00p-7:00p $250,00:30 51 $49.02) 215002 §1
Mo-Fr 6:00p-7:00p $350,00 :30 p6.a 850,72 p2e7.030 §1

ebe |GSF |ACTION NEWS AT 11PM |Mo-Fr 11:00p-11:30p $350,00:30 42| 3333 176.890 $1
Mo-Fr 11:00p-11:30p £450.00 :30 p5.3 £84.91| p221.827 g2

@CRcnn |various Mo-Fr 11:00p-11:30p $20,00 130 0.1 200,00 5.817 sz
[ ent |varIoUs Mo-Fr 11:00p-11:30p $20,00 130 0.2 §100.00) 10,260 §1
ESF ESPN  |VARIOUS Mo-Fr 11:00p-11:30p $40.00 130 0.4 §100.00) 16,582 §2
e GSF |ABC COLLEGE FOOTBALL|Sat 3:30p-7:00p $500,00 :30 p2.7| $185.19| pli2.713 $4

For an even more dramatic presentation, take it to the Planner Screen. Enter an equal budget for the
station and for cable. Watch the Multi-Media Summary as the package is being built.

Summaries | Grid Options  Flighting RTF Comment Rate Card LogicFlow BuyerGoals

| Multi-Media Summary ~ | Summarize Flight All ~ | Effective Reach 3 ~ @ Print Summaries...
Meda (DMA P25+) Spots £ Cost % Grps % | GrossImp. Reach  Freg CPP CPM
22 5 500000 50 6.4 68 3,627 384 22 6044 S1.6
Cable 400 95 §5,000.00 50 .0 31 1,875 8.9 4.3 5157.89 $3.2
Total 422 100 $12,000.00 100 114.4 100 5,502 439 2.8 596,46 $2.1

And, to make the obvious perfectly clear: create a Quick Chart, as shown below.

Quick Chart

Values | Options & Wertical Bar Chart - | B Edit Chart Title.. ¥7) Copy To Clipboard (3§ Print.. @Expurttu PowerPoint

a TV News (22 spots) vs Top Cable Nets (400 spots)
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ENT 33 %
HiLL 2 % CINN 2% STVL 1.6 %

) Hide all

Matice that only a few Cable Networks are shown.... the rest had no audience at all | H
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Where is that Chart?

The Planner Chart tab is right between Planner and Order at the top of the Planner or Avail grid. The
chart will default to Frequency Distribution, but in this case, Reach Per Station is needed. Just click the
drop-down menu to change this.

From here, click QuickChart. Edit the type of chart, the title, the label display, and even add a comment if
needed.

File| Edit View

Save Print Impart Copy  QuickChart
File Operations Chart Actions
™ | Internet LIVE REMOTE | Multi-Media ‘

Avails  Planner | Planner Charts | Order

i Chart [B® Reach Per Station =

From QuickChart, Copy to Clipboard, Print, and export to PDF, and even Export to PowerPoint.

Other ways to add Cable Networks:

Use the OTO. The station is the default, but click the drop down, to see all market cable stations that are
also available. Add the networks one at a time, and can get any time period wanted— WO Media Sales
will pull the correct ratings/000 from the book that’s been selected.
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There may be occasions on which an Avail/Package with certain cable stations selected is wanted. To do
this, select the station, remember to check Show Cable, then check any cable station needed to be
shown.
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Note: With a few exceptions, there will be no programming in WO Media Sales for all
o these cable networks. A Ratings Book must be chosen and then programming/ratings
for cable will pull from that book. (This can be more than one book, an average book
you create, or even Overnights. You'll see that it can’t be a Defined PAV book or an
Estimate/Selling book; if you’ve selected cable, those won’t be available.)

Selecting Rate levels won’t necessarily bring in rates, but it will make it easier to input and edit rates for
the station represented. Cable rates will be grayed initially — so plug in the cable/competitors rates for
comparison.

When in the Programming dialog in the new avail wizard, only choose Time Blocks can be chosen. This
does not mean program titles can’t be seen. Time Blocks are simply the way to pull information directly
from the Nielsen book; this is necessary when working with any station/network for which no Inventory
(programming) has been built in WO Media Sales.

Useable Time Blocks may be found (sometimes blocks set up specifically for Cable are available!), or
create an OTO, or even a permanent, additional time block (Click Setup).

{5 WO Meda Sales ]

New TV Campaign
|22

Programming

Select how you would like the system to pull the programming. “ iKBOShared Time Blocks R |
il (2 of 107 Time Blocks Selected)

Time Blocks | Times / Definitions | | o Select All

r @ Mo-5u 5:00a-%:59a  Mo-Su 5:005-%:593 [

I @ 4303 News Mo-Th 4:30a-5:00a SR

I @ 4303 News Mo-Th 4:30a-5:008+ add gT0..

Icd ® Early Morning Mo-Fr 5:00a-9:00a fl

I~ {5 paytime Mo-Fr 8:00a-%00p Setup... |

I @ Early Fringe Mo-Fr 4:00p-5:00p |

Icd ® Early News Mo-Fr 5:00p-7:00p+ |

l_ @ Prime Access Mo-5a §:30p-7:00p ||

™ {55 erime Mo-5u 7:00p-10:00p ‘
| —— e S {l
: < Back Next Cancel i
S

Y, Caution: See Time Blocks Guide in Quick Tips when setting up new Time Blocks. If a
- Research Director or anyone at the station maintains inventory or creates research
reports in WO Media Sales, please consult with that person FIRST!
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The Time Editor is the same as OTOs created before, but this screen may look new. Click the Default
Load Options tab.

What'’s shown here is an example of how one might tell WO Media Sales to pull their data. Often, cable
providers will sell in large time blocks, so that’s how we’re setting the report to pull ratings/ thousands
for each station selected (just choose Time Period Block for the size). Create 2 or 3 OTOs for the different
blocks the cable provider is selling.

o

[

r
{& WO Media Sales

Time Block

Time Block

Enter the name of the time block.

2 WO Media Salcs R

Time Block

Mo-Fr 5:002-9:01

Time Definitions

Times
Mo-Fr 6:00a-3:002

Default Load Options

Filters
Load All Programs for All 5t|

Time Block

Enter the name of the time block. | Mo-Fr 6:00a-9:00a

Time Definitions Default Load Options

Load Options

[7] Load PAV Programming

[7] Load Time Period Programming TP Block Size:
Days to Load
@ Al Days *) Individual Days (©) ExactDays

Al Days Example:

A time defined as MonFi 75-10p willlnad Monday, Tussday, Wednesday, Thursday, and
Friday programs as wel 2s programs that run Monday through Friday.

OK

) [

Cancel

A program average could be pulled, and if looking at prime, Individual Days might be selected, comparing
the station’s Monday night to theirs. Make different choices as needed; the point is to make the compari-
son between cable and the station as close to “apples to apples” as possible.

In the shot below, this appears in an Avail- full 12p-5p time blocks, and identical HUTS (from DMA).
The cable stations won’t have rates, but double-click on the gray cell, and enter the cable provider’s
rate, revealing their cost per point, or cost per thousand. Take this to the Planner Screen and schedule
spots. Don’t forget to look at your Multi-Media Summary!

emos.. & | %} Sorting...
Program Info DMA P18-54 -

n |DP \ |Program Name \Tlme |Ecck \Rate Level |Rabe |SL Rtg| Shr| PUT\ (
cle atg |various Mo-Fr 5:00a-8:00a  |May/2014L5 (None) : 0.0 0.2 2.0

C At Mo-Fr 5:00a-9:00a | May/2014LS . 2.0 216 9.0 4

c & |various Mo-Fr 5:00a-8:00a  |May/2014L5 (None) T30 0.2 24 2.0

c | [ various Mo-Fr 5:00a-2:00a  |May/2014L5 (None) :30 0.1 0.6 2.0

o B |usnmone Mo Ce Connn nunne tasetname Mhicect =0 nn an anl g

m r

ns| RTFComments LogicFlow TV DemoProfile Flighting
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Cable “Virtual” Station

Another alternative is to create a station in WO Media Sales which is actually an aggregate of all cable

in the market, or a subset of cable networks. This is something best handled by the Research Director

or whoever handles research tasks at the station. It would appear in the list of stations when an avail is
created, probably just as “Cable”. Choose it if it’s there, but consult with whoever handles inventory to
learn what stations are included. If it’s not there, and having such a station to work with would be useful,
we’ll be happy to help you with that.

If you must look at HWC numbers...

To see what numbers the competition is using use the Graphical Ranker, Program Ranker or Book
Comparison found in the View tab.

oo (T ]
i File Edit| | View || Tagged Items
| [ @ ntemet vh Hewspapar——| l @ Avails 'l @ order -l Trender Graphical Ranker Book Comparison

[ owm -][ @ Multi-Media v] [ @eeme TrendBuilder Program Ranker

Vedia Avals | Packages Research
™ | Internet | NTR | Multi-Media

avalls | Planner  Planner Charts  Order

S A

{ A EditDemos.. § | 4] Sorting.. Inventory | Deleted

[ Program Info | DMA P15-54 =1 I Pa1e% 1, B, 771 | 2% Add Station...

Now go to Edit Demos. HWC can be chosen. The clearest representaon will be in thousands, but choose
whatever is desired.

| e | NTR | Multi{ WO Media Sales. e — P——— ===
Planner  Planner Charts  Order | Graphical Ranker
554 DRTS 12 Select Demo Displays 2 Demos Selected
el Demo Area Start Age End Age Cale
Program Info @ wre Demo Calculation
~||N...[~] Baok. ~| Daypat [~ Pragiam Households 2 -s @ DMAPI8-54 DRTG
e May2014LS  EarlyFringe  VARIOUS *) Males 6 1 B @sﬂn @ B34 000
alle May2014LS  EarlyFringe  VARIOUS Cemales . w [ @pm i I
alle May2014LS  Early Morning  VARIDUS - S ’ & 00 !
aifle May2014LS  EarlyFringe  VARIOUS N Persons @ 18- ©-20 Q
Ml WW 18+ ®a- e T @ WWH i
. r @cb
oEo e [paazra ->] |
- Add DMA >>
. e DR e |
N i
| o PR @HSHR Add NST >> |
o ow Tl |
i . r @PDP |
|
< Remove |
Il i
<< Clear Al N
I
i
I |
M 1834 |
i
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When finished, click back to Avails.

Look at the big difference between DMA and HWC for the ABC station (top of the list). The difference
won’t be so great in some markets, but in this one HWC makes up only about 60% of the DMA. But the
cable stations are the same in both because we are displaying thousands here. If we show ratings, which
are a percentage of the universe, the number for the cable stations will be smaller in the DMA, and
larger in HWC. This concept is hard to explain to a local, direct buyer; Instead, explain that the numbers
the cable provider is using leave out any means of viewing the station other than Hard Wired Cable!

i A Edit Demos... § | £] Sorting...

Program In'. | Need Rate | DMA P35-54 | HWC P35-54
| Book |RateLevel |5 Zone |Rate |(000) |CPM Shr| PUT| CPM (000} Shr| PUT| CPM
Mo-Fr 6:00p-6:30p |LPMay/2015.3 |(None) ; A $0.00| 8.924 $0.00

M Mofr&:00p-6:30p |LPMay/2015.3  |(None) F) CH $0.00 4402 $0.00 *4.462 *0.81 *55L11 *4.462 =173 =258.42

M |Mo-Fr 6:00p-6:30p |LPMay/ 201503 (Mone) Q DMA £0.00| 1.386 $0.00 1.386 0.13 1102.22 1.386 0.27 516.84

M Mofr&:00p-6:30p |LPMay/2015.3  |(None) (e} CH $0.00| 0.693| s0.00 *0.693 *0.13| =*55L11 *0.693 *0.27 =258.42

M |MoFr6:00p-6:30p |LPMay/2015.3 1stQr 2015 K DMA $0.00| 47.737| $0.00 47.737 4.33 1102.22 $0.00 24.777 4.79 516.84 $0.00;
‘ M |MoFr6:00p-6:30p |LPMay /201503 1stQir 2015 K CH $0.00| 23.889| s0.00 ®23.869 *433| *55L1i1 §0.00| *12.389 =479 =258.42 $0.00|

M |MoFr6:30p-7:00p |LPMay/2015.3 1stQtr 2015 K DMA $0.00| 53.238| $0.00 53.238 437 1218.12 $0.00 26.485 4.76 556.10 $0.00;
" N Mo-Fr6:30p-7:00p | LPMay/2015L3 1stQr 2015 K CcH $0.00| 26.613| $0.00 *26.619 *4,37  *609.06 $0.00 *13.243 =3.76 *278.05 $0.00]

If you have any questions or concerns, please call or email support.

WO Media Sales Support:
415.675.6775 Option 2, 1
sales-support@wideorbit.com
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